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WARNING

Always wear eye protection when working with solvents or any pressurized liquids.

AVERTISSEMENT

Porter toujours des protections pour les yeux lorsque vous manipulez des solvants ou 
tout autre liquide sous pression.

WARNING

Use this product only as specified in this document. Using this system in a manner not 
specified may result in injury or damage to the system.

AVERTISSEMENT

Veuillez suivre avec attention les indications figurant dans ce document lorsque vous 
utilisez ce produit. Un usage différent le système causer un accident ou endommager 
le système.



WARNING

PEEK tubing is polymeric material. Use caution when working with any polymer tubing 
under pressure.
1. Always wear eye protection when in close proximity to pressurized polymer tubing.
2. Extinguish all nearby flames if using flammable solvents.
3. Do not use PEEK tubing that has been severely stressed or kinked.
4. Do not use PEEK tubing with tetrahydrofuran or concentrated nitric and sulfuric 

acids.
5. Methylene chloride and dimethyl sulfoxide cause PEEK tubing to swell and greatly 

reduce the rupture pressure of the tubing.
6. With high solvent flow rates (>40 ml/min), a static charge may build up on the 

surface of the tubing. Electrical sparks may result.

AVERTISSEMENT

Le tubage PEEK est un matériau polymère. Prenez des précautions lorsque vous 
travaillez avec un tubage polymère sous pression.
1. Porter toujours des protections pour les yeux lorsque vous vous trouvez à 

proximité d’un tubage polymère sous pression.
2. Éteindre toutes les flammes avoisinantes si vous utilisez des solvants 

inflammables.
3. Nes pas utiliser un tubage PEEK qui a déjà été sérieusement travaillé ou plié.
4. Nes pas utiliser un tubage PEEK avec du tétrahydrofurane ou des acides nitriques 

et sulfuriques concentrés.
5. Le chlorure de méthylène et le sulfoxyde de diméthyle entraînent un gonflement 

du tubage PEEK et réduisent fortement la résistance à la rupture du tubage.
6. Avec des débits d’écoulement de solvants élevés (>á 40 ml/min), une charge 

statique puet se développer sur la surface du tubage. Des étincelles électriques 
peuvent en résulter.



WARNING

For continued protection against fire hazard, replace fuses with those of the same type 
and rating.

AVERTISSEMENT

Pour une protection permanente contre le danger d’incendie, remplacez les fusibles 
existants avec des fusibles similaires, présentant les mêmes caractéristiques.

WARNING

Before handling any chemicals, refer to the Material Safety Data Sheet provided by 
the manufacturer, and observe all relevant precautions.

AVERTISSEMENT

Avant de manipuler des produits chimiques, veuillez consulter la fiche de sécurité du 
matériel fournie par le fabricant, et observer les mesures de précaution qui 
s'imposent.

CAUTION

Failure to flush the system after daily use may result in system downtime. Refer to 
Section 3.6, Flushing the SCOUT Column Selector After Use, for the recommended 
procedure.



US Safety and EMC (Electromagnetic Compatibility) Standards

Safety
This instrument has been tested to and complies with standard ANSI/UL 3101-1, “Electrical 
Equipment for Laboratory Use; Part 1: General Requirements”, 1st Edition. It is an ETL Testing 
Laboratories listed product.

EMC

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause undesired operation.

Warning: Changes or modifications to this unit not expressly approved by the party responsible for 
compliance could void the user’s authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with 
the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be required 
to correct the interference at his own expense.

Note: Shielded cables must be used with this unit to ensure compliance with the Class A FCC limits.



Canadian Safety and EMC (Electromagnetic Compatibility) Standards

Safety
This instrument has been tested to and complies with standard C22.2 No. 151, “Safety 
Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use; Part 1: 
General Requirements”. It is an ETL Testing Laboratories listed product.

Sécurité
Cet instrument a été vérifié avec la norme C22.2 No. 151, «Spécifications de sécurité du matériel 
électrique utilisé pour les mesures, les contrôles et dans les laboratoires ; Partie 1 : Spécifications 
générales», et il est conforme à cette norme. C’est un produit homologué par les ETL Testing 
Laboratories.

EMC
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing 
Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le 
materiel brouilleur du Canada.



European Safety and EMC (Electromagnetic Compatibility) Standards

Declaration of Conformity

Application of Council Directive(s): 73/23/EEC “Low Voltage” 

89/336/EEC “Electromagnetic Compatibility”

Standard(s) to which conformity is 
declared:

EN61010-1 “Safety Requirements for Electrical Equipment for Mea-
surement, Control and Laboratory Use”

EN55011:1991, Group 1, Class B “Radiated Emissions”

EN50082-1:1991 “Generic Immunity”

Manufacturer’s Name: Applied Biosystems

Manufacturer’s Address: 500 Old Connecticut Path

Framingham, Massachusetts 01701 USA

Type of Equipment: Laboratory Instrumentation

Model Name & Number: SCOUT Column Selector

Part Number: 5-2287-00

Serial Number: 250 and later

Year of Manufacture: 1997
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How to Use This Guide

Purpose of this
guide

Applied Biosystems’ SCOUT® Column Selector User 
Guide contains the procedures for installing, running, 
maintaining, and troubleshooting the SCOUT® Column 
Selector.

Audience This guide is intended for novice and experienced SCOUT 
Column Selector users who are developing and executing 
analytical and preparative separation protocols of 
biomolecules based on POROS® Perfusion 
Chromatography® media and conventional 
chromatography media. 

Structure of
this guide

Applied Biosystems’ SCOUT® Column Selector User 
Guide is divided into four chapters and three appendixes.

The table below describes the material covered in each 
chapter and appendix. 

Chapter Content

Chapter 1, Introducing the SCOUT 
Column Selector

Describes the features and parts of the SCOUT 
Column Selector.

Chapter 2, Installing a Stand-Alone 
SCOUT Column Selector

Provides procedures for installing a stand-alone 
SCOUT Column Selector hardware and software. 

Chapter 3, Using the SCOUT 
Column Selector

Provides procedures for plumbing, configuring, 
and using the SCOUT column selector, including 
running a method, using the column switching 
template, viewing Group Analysis, and flushing 
the SCOUT column selector after use.

Chapter 4, Maintenance and 
Troubleshooting

Describes maintenance procedures and includes 
troubleshooting information and error codes.

Appendix A, Specifications Includes system specifications.
SCOUT ® Column Selector User Guide xi
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Conventions This guide uses the following conventions to make text 
easier to understand.

General
conventions

• Bold text indicates user action. For example:

“Type 0 and press Enter for the remaining 
fields.” 

• Italic text denotes new or important words, and is 
also used for emphasis. For example:

“Prior to operation, always check for 
eluent miscibility.”

Notes, Cautions,
and Warnings

A Note calls out important information to the operator. 
For example:

NOTE: Record your result before proceeding with the 
next step. 

A Caution provides information to avoid damage to the 
system or loss of data. For example:

CAUTION
Do not touch the flow cell window. This may damage 
the flow cell.

Appendix B, Spare Parts Includes ordering information for spare parts.

Appendix C, Warranty/Service 
Information

Includes warranty information.

Chapter Content
xii Applied Biosystems
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A Warning provides specific information essential to the 
safety of the operator. For example:

WARNING
Always observe safe laboratory practices when 
operating your system.

Remarques,
recommandations
et avertissements

Une remarque fournit une information importante à 
l’opérateur er se présente ainsi:

REMARQUE: Si on vous demande d’insérer la 
disquette de démarrage dans le lecteur, insérez-la puis 
appuyez sur n’importe quelle touche.

Une recommandation fournit une information destinée à 
éviter des détériorations du système ou la perte de 
données:

RECOMMANDATION 
La lampe peut être endommagée. N’y touchez pas.

Un avertissement fournit une information indispensable à 
la sécurité de l’operateur et se présente ainsi:

AVERTISSEMENT
Conformez-vous toujours aux règlements du laboratoire 
quand vous utilisez votre système.

Symbols used
on the system

The following symbol appears next to the values of the 
fuses required by the system.
SCOUT ® Column Selector User Guide xiii
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Related

documentation
Use this document in conjunction with the appropriate 
document for your system:

• Applied Biosystems’ BioCAD ® Workstation for 
Perfusion Chromatography User Guide 

• Applied Biosystems’ BioCAD ®/ SPRINT ™ System 
for Perfusion Chromatography User Guide 

• Applied Biosystems’ BioCAD ® 700E Workstation 
for Perfusion Chromatography User Guide

• Applied Biosystems’ VISION ™ Workstation for 
Perfusion Chromatography User Guide

• Applied Biosystems’ INTEGRAL™ 100Q System 
User Guide

Send us your
comments

Applied Biosystems welcomes your comments and 
suggestions for improving its manuals. You can send 
your comments in two ways: 

• Use the Technical Publications Customer Survey 
at:

www.appliedbiosystems.com/perseptive/techsup/survey.htm

• Send e-mail to: 

techpubs@appliedbiosystems.com
xiv Applied Biosystems
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Chapter
1  Introducing 
the SCOUT 
Column Selector
This chapter includes the following sections:

1.1 SCOUT Column Selector Features ........... 1-2

1.2 Parts of the SCOUT Column Selector ....... 1-3
SCOUT ® Column Selector User Guide 1-1
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 1.1  SCOUT Column Selector 
Features

Overview Applied Biosystems’ SCOUT® Column Selector is an 
automated multi-column switching unit for use with the 
BioCAD® family of workstations and the INTEGRAL™ 100Q 
System. The SCOUT Column Selector allows flow to be 
diverted to any one of six attached columns. 

The SCOUT Column Selector offers increased flexibility for 
both systematic methods development and routine execution 
of experiments.

A new template added to your system software allows you to 
program columns to be switched sequentially or repeatedly 
depending on your application.

Features The SCOUT Column Selector provides the following features:

• Allows you to screen a range of columns and media to 
systematically determine the effect of selectivity on the 
desired separation

• Includes column clips that are compatible with columns 
up to 24 mm in diameter and 30 cm in length

• Is compatible with ID™ Sensor Cartridges to allow 
sequential peak tracking and Poroszyme™ Immobilized 
Enzyme Cartridges to allow online enzymatic digestions

• On BioCAD, BioCAD 700E, and VISION systems, can 
be plumbed at any position in the tandem column or 
three column configuration to allow for automated multi-
dimensional chromatography methods development
1-2 Applied Biosystems
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1.2  Parts of the SCOUT 
Column Selector

SCOUT models This document describes two SCOUT models:

• Stand-alone—A free-standing unit available with 
BioCAD/SPRINT™ Systems, BioCAD® Workstations, 
BioCAD® 700E Workstations, and INTEGRAL™100Q 
Multidimensional Biospecific HPLC Systems 
(Figure 1-1).

Figure 1-1  Stand-Alone SCOUT Column Selector

• Built-in—Part of the VISION Workstation (Figure 1-2). 

Figure 1-2  Built-In SCOUT Column Selector on VISION Workstation

PB100370

PB100512

SCOUT Column
Selector
 SCOUT ® Column Selector User Guide 1-3
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1
 Parts of the
SCOUT

The SCOUT Column Selector includes the following parts 
(shown in Figure 1-3 and Figure 1-4):

• Column clips—Allow you to mount and secure 
columns easily.

• Hinge (stand-alone model only)—Allows you to tilt the 
column holder for easy access to the outlet ends of the 
mounted columns.

• Valves —Top valve and bottom valve (not shown) allow 
you to connect columns for switching.

• Front panel —Includes yellow Column LEDs that 
indicate the column in use and a red Fault LED that 
indicates a valve switching problem. The stand-alone 
unit also includes a green Power LED that is lit when 
the unit is on.

Figure 1-3  Stand-Alone SCOUT Column Selector

PB100370

hinge

valve

Column
clips

Column
holder

Front 
panel

Top

Column
 holder
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Figure 1-4  Built-in SCOUT Column Selector on VISION Workstation

PB100513

valve

Column
clips

Front 
panel

Top
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Chapter
2  Installing a

Stand-Alone
SCOUT
Column Selector
This chapter includes the following sections:

2.1 Installing the Hardware ............................. 2-2

2.2 Installing the Software............................... 2-5

NOTE: If you have a VISION Workstation, skip this chapter. The SCOUT Column 
Selector is built-in to the VISION Workstation, and you do not need to connect it. 
SCOUT ® Column Selector User Guide 2-1
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2.1  Installing the Hardware

Power
requirements

The stand-alone SCOUT Column Selector requires:

Connecting To connect the SCOUT Column Selector to a BioCAD, 
BioCAD 700E, BioCAD/SPRINT, or INTEGRAL 100Q system:

CAUTION

Power down the system to which you are connecting the 
SCOUT Column Selector. When the SCOUT Column 
Selector is connected, power up the SCOUT Column 
Selector first and then power up your system.

1. Place the SCOUT unit on the top left side or next to the 
right side of your system.

2. Power down your system.

3. If your system includes a serial mouse (connected to 
COM1 with a 9-pin D connector), connect the SCOUT to 
COM2.

NOTE: If you have another device connected to COM2, 
you must disconnect it before you connect the SCOUT.

If your system includes a PS/2 mouse (connected to a 
special port with a round connector), connect the 
SCOUT to COM1 or COM2.

Power 115–230 Vac, 1.2 A, 50/60 Hz

Fuse T2A, 250V, SLO-BLO™
2-2 Applied Biosystems
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4. Select the 9-pin or 25-pin adaptor (depending on the COM 
port you are connecting to) and plug it in to a COM port on 
your system. Figure 2-1 and Figure 2-2 show the COM 
ports on BioCAD systems. 

Figure 2-1  Connecting the SCOUT to a System with a PS/2 Mouse

Figure 2-2  Connecting the SCOUT to a System with a Serial Mouse

PB100389
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Auto
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Collector

Integrator

Chart Recorder

COM2
(25 pin)

COM1
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PB100043
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Chart Recorder

COM2
(25 pin or 9 pin)
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NOTE: The COM2 port may be in a different position if 
your system model is older than the system model 
shown in Figure 2-2.

5. Connect the communications cable to the adaptor in the 
COM port.

6. Connect the other end of the communications cable to the 
communications port on the rear panel of the SCOUT 
Column Selector (Figure 2-3).

Figure 2-3  Rear Panel

7. Connect the power cord to the SCOUT Column Selector 
and plug it in to the electrical power source.

8. Power up the SCOUT Column Selector by pressing the 
power switch on the rear panel.

9. Power up your system.

PB100376

Power connector

Power switch

Communications
port
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2.2  Installing the Software

This section describes:

• Installing the software
• Updating the hardware configuration
• Starting the software

Installation
requirements

Install the following version of software required by the 
SCOUT Column Selector depending on your system:

• Version 1.25 or later of BioCAD software
• Version 2.05 or later of INTEGRAL software

NOTE: If the required version of software is already 
installed on your system, skip this section.

Installing To install the system software:

1. At the C:\> prompt, type WIN and press Enter to start 
Windows.

2. Insert Disk #1 in the system floppy disk drive.

3. In the Program Manager window, select Run from the File 
menu.

4. Type A:\SETUP and click OK. 

5. Follow the instructions displayed on the screen.

When the installation is complete, a message is 
displayed.
SCOUT ® Column Selector User Guide 2-5
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Updating the
hardware

configuration

After installing the software, update the hardware 
configuration to activate the SCOUT software.

To update the configuration:

1. Double-click the Setup icon in the BioCAD or 
INTEGRAL program window in the Windows Program 
Manager. 

The Installation dialog box is displayed.

NOTE: If the BioCAD or INTEGRAL program window is 
not displayed, select it from the Window menu in the 
Windows Program Manager.

2. Click Continue.

The Installation Options dialog box is displayed.

3. Select Update Hardware Configuration and click 
Continue.

4. Follow the directions displayed on the screen to activate 
the SCOUT and other hardware options for your system. 
Refer to the user’s guide for your system for more 
information.

NOTE: If your system includes a serial mouse 
(connected to COM1 with a 9-pin D connector), you can 
connect and activate only one external device. If your 
system includes a PS-2 mouse (connected to a special 
port with a round connector), you can connect and 
activate two external devices.

When the update is complete, a Setup Succeeded 
message is displayed.

5. Click OK to leave the update program.
2-6 Applied Biosystems



Installing the Software

2

Starting
the software

There are two ways to start your system software:

• From the C:\> prompt—If you exit Windows, you can 
start the software from the C:\> prompt. 

Depending on your system, type WIN BIOCAD or 
WIN INTEGRAL to start the system software.

NOTE: To start Microsoft Windows without starting 
the BioCAD or INTEGRAL software, type WIN.

• From the Windows Program Manager—When you 
power up the system or exit the BioCAD software, 
double-click the BioCAD or INTEGRAL icon to start the 
software (Figure 2-4).

Figure 2-4   Program Manager with BioCAD Icon

NOTE: If the BioCAD or INTEGRAL program window is not 
displayed, select it from the Window menu in the Windows 
Program Manager.

The Control Panel is displayed when you start up the software.

Double-click
here
SCOUT ® Column Selector User Guide 2-7
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NOTE: The software automatically checks to make sure 
that at least 5% of your system hard drive is free. If the 
space is inadequate, a warning is displayed. You can exit 
the software and delete files from the hard drive to make 
more room.
2-8 Applied Biosystems
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Chapter
3  Using the SCOUT
Column Selector
This chapter includes the following sections:

3.1 Plumbing the SCOUT Column Selector .... 3-2

3.2 Configuring the SCOUT Columns............. 3-7

3.3 Running a SCOUT Method ...................... 3-9

3.4 Using the Column Switching Template ... 3-12

3.5 Viewing Data.......................................... 3-14

3.6 Flushing the SCOUT Column Selector 
After Use ............................................... 3-15
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3.1  Plumbing the SCOUT 
Column Selector

This section describes:

• Preparing SCOUT hex nut fittings

• Connecting columns to the SCOUT Column 
Selector

• Plumbing the SCOUT Column Selector to your 
system

3.1.1  Preparing SCOUT Hex Nut Fittings

Use hex nut fittings supplied in the Hex Nut Fittings Kit to 
connect tubing to the 7-valve ports on the top and bottom 
of the SCOUT Column Selector. 

To connect the SCOUT hex nut fittings to tubing:

1. Slip a compression fitting over the end of the 
tubing.

2. Slip a ferrule over the end of the tubing, with the 
tapered end pointing away from the compression 
fitting. Make sure at least 1/8-inch of tubing extends 
beyond the ferrule (Figure 3-1).
3-2 Applied Biosystems
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Figure 3-1  Connecting SCOUT Hex Nut Fittings 
to Tubing

3. Insert tubing with attached ferrule into the union 
(provided in the Hex Nut Fitting Kit). Insert the tubing 
until the end is pressed against the inside of the 
union.

4. Use the 1/4-inch hex socket wrench (provided in the 
Hex Nut Fitting Kit) to tighten the compression fitting 
until snug.

5. Loosen the compression fitting and remove the tubing 
from the union.

Check that the ferrule is tight enough on the tubing 
that it does not slide off.

PB100536

Compression
Ferrulefitting
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3.1.2  Connecting Columns to the 
SCOUT Column Selector

To connect columns to the SCOUT Column Selector:

1. Place the columns in the column clips.

2. Connect the columns to the top SCOUT valve using 
the fittings prepared in the previous section. See 
Figure 3-2. Refer to the user’s guide for your system 
for more detailed information on fittings for your 
system.

Figure 3-2  SCOUT Plumbing Diagram
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3. Plumb high-pressure unions in any positions without 
columns to prevent accidental leakage if a position 
without a column is selected.

4. If you have a stand-alone SCOUT Column Selector, 
you can tilt the column holder to access the bottom of 
the column selector (Figure 3-3):

• Hold the bottom of the unit while pulling 
the column holder toward you

• Pivot the column holder up until it seats in 
a tilted position

• Pull the tilted column holder toward you 
until it drops down and locks in the tilted 
position

Figure 3-3  Tilting the Stand-Alone Column Holder

5. Connect the columns to the bottom SCOUT valve 
using the fittings prepared in the previous section.

Refer to Figure 3-2 for tubing connections.

6. Connect the center ports on the top and bottom 
valves to the system as shown in Figure 3-2.

PB100372
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3.1.3  Plumbing the SCOUT Column Selector 
to Your System

The connections to and from your system depend on the 
column configuration (single column, tandem column, 
three column) of your system. 

To determine the appropriate connections to plumb the 
SCOUT unit to your workstation, refer to:

• Figure 3-2
• Plumbing diagram specific for your system
• User guide for your system
3-6 Applied Biosystems



Configuring the SCOUT Columns

3

3.2  Configuring the SCOUT
Columns

Edit the configuration of your workstation to specify the 
SCOUT Column Selector and its columns.

From the Control Panel:

1. Select Edit Config from the Config menu.

The Configuration dialog box is displayed. 
Figure 3-4 shows the Plumbing section of the 
Configuration dialog box. 

Figure 3-4  Plumbing in Configuration Dialog Box

NOTE: The SPRINT Configuration dialog box does 
not include the Column Option field.

2. Select the SCOUT checkbox. 
SCOUT ® Column Selector User Guide 3-7
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3. If you are using a BioCAD/SPRINT system, skip to 
step 4.

If you are using a BioCAD, BioCAD 700E, VISION, 
or INTEGRAL 100Q system:

• Under the plumbing heading, select a 
Column Option.

• Select the column position to which the 
SCOUT device is configured, if necessary.

4. Select the required columns from the column library 
scroll list.

5. Configure the rest of the settings as needed. Refer to 
the user’s guide for your system for more information.

6. Click OK when the configuration is complete.

If the column is … Then …

not connected to the 
SCOUT Column 
Selector (columns with 
numbers only, for 
example, 1, 2, 3)

• double-click on the 
column line 

• select the appropriate 
column from the column 
library and then click OK

connected to the 
SCOUT (columns with 
numbers and letters, for 
example, 1A, 1B, 1C)

for each column:

• determine the column 
type connected to the 
position that you are 
configuring

• double-click the position 
you are configuring on the 
column line and select the 
appropriate column from 
the column library

• click OK
3-8 Applied Biosystems
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3.3  Running a SCOUT Method

To run a method using the SCOUT Column Selector, you 
create a method and perform the following steps:

• Specify the initial SCOUT column state in the 
general settings

• Add a SCOUT event to the method to switch 
columns

Refer to the user’s guide for your system for more detailed 
information about creating methods.

3.3.1  Editing General Settings

To edit the General Settings of a method:

1. Select Method Editor from the Window menu.

2. Double-click the General Settings line in the method.

The General Settings dialog box is displayed. The 
choices available depend on the column 
configuration on your system. Figure 3-5 shows the 
BioCAD General Settings dialog box.

Figure 3-5  BioCAD General Settings Dialog Box

SCOUT device 
in position 2configured 
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3. Select the Initial Column State. 

If you select a SCOUT column position, select the 
SCOUT column to use from the drop-down list box.

4. Set the rest of the General Settings as needed. Refer 
to the user’s guide for your system for more 
information.

5. Click OK.

3.3.2  Adding a SCOUT Event

You can add a SCOUT event to any segment of your 
method to switch columns.

1. Select the segment in the Method Editor window.

2. Click Add Event.

The Add Event dialog box is displayed (Figure 3-6).

Figure 3-6  Add Event Dialog Box
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3. Select Set SCOUT Column and click Add.

The Set SCOUT column dialog box is displayed 
(Figure 3-7).

Figure 3-7  Set SCOUT Column Dialog Box

4. Select the column from the Change To list box.

5. Type the time, volume, or CV value in the At text box. 
The units depend on the units of the selected 
segment.

6. Click OK.

The event is inserted into the method.

7. Select Save from the File menu to save the method.
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3.4  Using the Column Switching 
Template

After you create a method, you can use the column 
switching template to run your method. To run the 
template from the Method Editor window, perform the 
following procedure:

1. Select Column Switching from the Templates 
menu.

The Column Switching Template dialog box is 
displayed (Figure 3-8).

Figure 3-8  Column Switching Template Dialog Box

2. Click the appropriate option:

Number
of runs

If you want to … Then click …

use each column for one 
run before switching to 
the next column 

sequentially
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For example, if you specify 3 runs for column 2A, 
2 runs for column 2B, and 1 run for column 2C, the 
columns will be switched in the sequence shown in 
Table 3-1. 

3. Enter the number of runs for each column. 

4. Click Run.

The template runs.

use the same column for 
the specified number of 
runs before switching to 
the next column

repeatedly

If you want to … Then click …

Table 3-1   Run Sequence

Sequentially Repeatedly

Run Column Run Column

1 2A 1 2A

2 2B 2 2A

3 2C 3 2A

4 2A 4 2B

5 2B 5 2B

6 2A 6 2C
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3.5  Viewing Data

When you view data files generated using the SCOUT 
column selector, information about the column is included 
in the file title. 

The title includes the file name, the position of the column 
on the SCOUT, and column identification. 

Figure 3-9  SCOUT Data Files

File name

Column
identification

Column position
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3.6  Flushing the SCOUT Column
Selector After Use

Flush the SCOUT Column Selector with water before you 
shut down your system. Flushing prevents salt buildup in 
the valves.

1. Remove the columns from the SCOUT device and 
replace them with unions.

2. Place the buffer/solvent lines in deionized water.

3. Create a method to flush each SCOUT column 
position with 20 ml of deionized water. An example 
method is shown in Figure 3-10.
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Figure 3-10  Method for Flushing SCOUT

4. Select Run Method from the File menu.
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Chapter
4  Maintenance and
Troubleshooting
This chapter includes the following sections:

4.1 Maintenance ............................................. 4-2

4.2 Troubleshooting ........................................ 4-4
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4.1  Maintenance

Replacing the
fuse

Use the following procedure to replace the fuse in a 
stand-alone SCOUT Column Selector.

1. Power down the SCOUT Column Selector.

2. Remove the power cord.

3. Pry out the fuse block using a small flat-blade 
screwdriver (Figure 4-1).

Figure 4-1  Replacing the Fuse

Fuse block

PB100373
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WARNING
For continued protection against fire hazard, 
replace fuses with those of the same type and 
rating.

AVERTISSEMENT

Pour une protection permanente contre le danger 
d’incendie, remplacez les fusibles existants avec 
des fusibles similaires, présentant les mêmes 
caractéristiques.

4. Remove the fuse and replace with a 2-amp fuse.

5. Replace the fuse block.

6. Replace the power cord. 

7. Power up the device.
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4.2  Troubleshooting

This section contains troubleshooting information for:

• Front Panel LEDs
• Error codes

Technical support If you are unable to solve problems using the guidelines in 
the following sections, call Applied Biosystems Technical 
Support. Refer to the back cover of this document for the 
appropriate office.

4.2.1  Front Panel LEDs

The front panel LEDs indicate the status of the system. 
The following chart describes the functions of the LEDs.

Symptom Possible Cause Action

LEDs off (yellow) No electrical power Ensure device is plugged in 
to power source.

Faulty fuse Replace fuse. See 
“Replacing the fuse” on 
page 4-2.

Fault light on (red) Valves unable to switch 
positions 

NOTE: An intermittently lit 
Fault light indicates a 
mechanical problem. Call 
Applied Biosystems 
Technical Support.

Use the Control Panel to 
manually switch the valves. If 
the error occurs again, call 
Applied Biosystems 
Technical Support.
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4.2.2  Error Codes

Error codes may be displayed in the software during 
system operation. Codes are also displayed in the Event 
Log window. See the user guide for your system for more 
information about the event log. Error codes associated 
with the SCOUT Column Selector are listed in Table 4-1.

Table 4-1   Error Codes

Symptom Possible Cause Action

SCOUT [COM 2]: 
Failed to Respond

Communications 
error

Verify cables and connectors are 
connected properly. See Chapter 2, 
Installing a Stand-Alone SCOUT 
Column Selector.

SCOUT device is not 
powered up

Power up SCOUT device.

Device not 
connected to 
workstation

Verify cables and connectors are 
connected properly. See Chapter 2, 
Installing a Stand-Alone SCOUT 
Column Selector.

Defective cables or 
connectors

Inspect cables and connectors and 
replace if necessary.
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SCOUT [COM 2]: 
Reported 0 
positions, 
Expected 6

Communications 
error

Verify cables and connectors are 
connected properly. See Chapter 2, 
Installing a Stand-Alone SCOUT 
Column Selector.

Device not 
connected to 
workstation

Verify cables and connectors are 
connected properly. See Chapter 2, 
Installing a Stand-Alone SCOUT 
Column Selector.

Defective cables or 
connectors

Inspect cables and connectors and 
replace if necessary.

SCOUT [COM 2]: 
could not transmit 
initialization (1)

Communications 
error

Call Applied Biosystems Technical 
Support.

SCOUT [COM 2]: did 
not receive valid 
response

Communications 
error

Verify cables and connectors are 
connected properly. See Chapter 2, 
Installing a Stand-Alone SCOUT 
Column Selector.

Wrong firmware 
version

Call Applied Biosystems Technical 
Support.

SCOUT [COM 2]: 
Valve Stuck Near 
Position n

SCOUT device is 
malfunctioning

Power the SCOUT Column Selector 
on and off and restart the software. 
See “Starting the software” on 
page 2-7.

SCOUT [COM 2]: 
Valve Stuck In 
Position n

SCOUT device is 
malfunctioning

Power the SCOUT Column Selector 
off and on and restart the software. 
See “Starting the software” on 
page 2-7.

Table 4-1   Error Codes (Continued)

Symptom Possible Cause Action
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Comm Port Conflict: 
<device name> 
Requested Comm 
Port n. That port is 
already owned by 
SCOUT.

Same 
communications port 
specified for SCOUT 
and another device 

Reinstall the software, performing a 
full installation. See Section 2.2, 
Installing the Software.

Table 4-1   Error Codes (Continued)

Symptom Possible Cause Action
SCOUT ® Column Selector User Guide 4-7



Chapter  4    Maintenance and Troubleshooting

4

4-8 Applied Biosystems



A
ppendix
A

A  Specifications
This Appendix includes specifications for the SCOUT Column 
Selector.

Table A-1   General Specifications

Property Specification

Valve body/fluid 
paths

PEEK, carbon-filled PEEK, PTFE, or 
HMW polyketone

Maximum 
pressure

3,000 psi

Back pressure <100 psi at 60 ml/min for each line

Column sizes Up to 24 mm diameter and up to 
30 cm length 

Column selection Access time:

• Column-to-column <100 msec 
• Random access <200 msec 

Plumbing 1/16-inch Valco fittings
SCOUT ® Column Selector User Guide A-1
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Dimensions 9.5 in. W x 12 in. L x 8 5/16 in. H

(24.1 cm W x 30.5 cm L x 2 1.1 cm H)

Weight 10 lb. (4.5 Kg)

Power 
requirements

100V/120V/220V/240V Universal

50/60 Hz ac

1.2 amps

Fuse rating 2-amp SLO-BLO™

Operating 
temperature 

4 to 40°C

Operating 
humidity 

10 to 90% non-condensing

Property Specification
A-2 Applied Biosystems
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B  Spare Parts
This appendix contains part numbers for SCOUT® Column 
Selector spare parts.

Table B-1    Spare Parts

Item Part Number

SCOUT Fitting Kit

Contains:

Fittings

Ferrules

P5-2208-00-5100

BioCad Fuse Kit, 2 amp SLO-BLO™ P5-1953-02-0000
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C  Warranty/Service
Information
Applied Biosystems supplies or recommends certain 
configurations of computer hardware, software, and 
peripherals for use with its instrumentation. Applied 
Biosystems reserves the right to decline support for or impose 
charges for supporting nonstandard computer configurations 
or components that have not been supplied or recommended 
by Applied Biosystems. Applied Biosystems also reserves the 
right to require that computer hardware and software be 
restored to the standard configuration prior to providing 
service or technical support. For systems such as VISION™, 
BioCAD™, SPRINT™, or INTEGRAL™ which have built-in 
computers, installing unauthorized hardware or software may 
void the Warranty or Service Plan.
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C.1  Limited Product Warranty

Limited warranty Applied Biosystems warrants that all standard components of 
its new instrument workstations will be free of defects in 
materials and workmanship for a period of ninety (90) days. 
Applied Biosystems will repair or replace, at its discretion, all 
defective components during this warranty period. After this 
warranty period, repairs and replacement components may be 
purchased from Applied Biosystems at its published rates. 
Applied Biosystems also provides service agreements for 
post-warranty coverage. Applied Biosystems reserves the 
right to use new, repaired, or refurbished instruments or 
components for warranty and post-warranty service 
agreement replacements. Repair or replacement of products 
or components under warranty does not extend the original 
warranty period.

Applied Biosystems warrants that all optional accessories 
supplied with its instrument workstations, such as peripherals, 
printers, and special monitors, will be free of defects in 
materials and workmanship for a period of ninety (90) days. 
Applied Biosystems will repair or replace, at its discretion, 
defective accessories during this warranty period. After this 
warranty period, Applied Biosystems will pass on to the buyer, 
to the extent that it is permitted to do so, the warranty of the 
original manufacturer for such accessories.

With the exception of consumable and maintenance items, 
replaceable products or components used on the instrument 
are themselves warranted to be free of defects in materials 
and workmanship for ninety (90) days.

Applied Biosystems warrants that chemicals and other 
consumable products will be free of defects in materials and 
workmanship when received by the buyer, but not thereafter, 
unless otherwise specified in documentation accompanying 
the product.
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Applied Biosystems warrants that for a period of ninety (90) 
days from the date of installation, the software designated for 
use with the product will perform substantially in accordance 
with the function and features described in its accompanying 
documentation when properly installed on the product. Applied 
Biosystems does not warrant that the operation of the 
instrument or software will be uninterrupted or error free. 
Applied Biosystems will provide any software corrections or 
“bug-fixes” if and when they become available, for a period of 
ninety (90) days after installation.

Warranty period
effective date

Any applicable warranty period under these sections will begin 
on the date of installation for hardware and software installed 
by Applied Biosystems personnel, unless that date has been 
delayed at the buyer's request. In that case, and for all 
hardware and software installed by the buyer, and for all other 
products, the applicable warranty period begins the date the 
component is received by the buyer.

Warranty
exceptions

The above warranties shall not apply to defects resulting from 
misuse, neglect, or accident, including without limitation: 
operation with incompatible solvents or samples in the system; 
operation outside of the environmental or use specification 
instructions for the product or accessories; performance of 
improper or inadequate maintenance by the user; installation 
of software or interfacing not supplied by Applied Biosystems; 
and modification or repair of the product or the software not 
authorized by Applied Biosystems.

The foregoing provisions set forth Applied Biosystems’ sole 
and exclusive representations, warranties, and obligations 
with respect to its products, and Applied Biosystems makes no 
other warranty of any kind whatsoever, expressed or implied, 
including without limitation, warranties of merchantability and 
fitness for a particular purpose, whether arising from a statute 
or otherwise in law or from a course of dealing or usage of 
trade, all of which are expressly disclaimed. Such limited 
warranty is given only to buyer or any third party in the event 
of use of products furnished hereunder by any third party.
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Warranty
limitations

The remedies provided herein are the buyer’s sole and 
exclusive remedies. Without limiting the generality of the 
foregoing, in no event shall Applied Biosystems be liable, 
whether in contract, in tort, warranty, or under any statute 
(including without limitation, any trade practice, unfair 
competition, or other statute of similar import) or on any other 
basis, for direct, indirect, punitive, incidental, multiple, 
consequential, or special damages sustained by the buyer or 
any other person, whether or not foreseeable and whether or 
not Applied Biosystems is advised of the possibility of such 
damage, including without limitation, damage arising from or 
related to loss of use, loss of data, failure or interruption in the 
operation of any equipment or software, delay in repair or 
replacement, or for loss of revenue or profits, loss of good will, 
loss of business or other financial loss or personal injury or 
property damage.

No agent, employee, or representative of Applied Biosystems 
has any authority to bind Applied Biosystems to any 
affirmation, representation, or warranty concerning the product 
that is not contained in this Limited Warranty Statement. Any 
such affirmation, representation, or warranty made by any 
agent, employee, or representative of Applied Biosystems will 
not be binding on Applied Biosystems.

This warranty is limited to the buyer of the product from 
Applied Biosystems and is not transferable.
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C.2  Damages, Claims, Returns

Damages Unpack shipments promptly after receipt to check for any 
concealed damage. 

If you discover damage, stop unpacking. Contact the shipping 
carrier and request inspection by a local agent. Secure a 
written report of the findings to support any claim. Do not 
return damaged goods to Applied Biosystems without first 
securing an inspection report and contacting Applied 
Biosystems Technical Support for a Return Authorization (RA) 
number.

Claims After a damage inspection report is secured, Applied 
Biosystems will supply the replacements and process claims 
that are initiated by either party.

Returns Do not return any material without prior notification and 
authorization. 

If for any reason it becomes necessary to return material to 
Applied Biosystems, contact Applied Biosystems Technical 
Support or your nearest Applied Biosystems subsidiary or 
distributor for a return authorization (RA) number and 
forwarding address. Place the RA number in a prominent 
location on the outside of the shipping container, and return 
the material to the appropriate address.
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